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Room Fire 
This is a more complex example. Although the geometry of the model is relatively simple, the fire is 

ignited by glowing particles that heat the sofa upholstery. The upholstery releases fuel and the fire 

results. As fuel is released, the sofa burns away.  

This approach to modeling a fire pushes the limits of FDS capabilities and is beyond the usual heat 

release rate approach used by fire safety engineers. This detailed approach may be used by researchers 

or forensic investigators. The uncertainties in this detailed modeling are large. 

This example is a simplification of the room fire problem provided by NIST as an FDS verification 

problem. The simplifications are in the geometry; the material properties and approach to modeling fire 

is the same as used by NIST.  

 

Figure 1. Room fire in this example 

This tutorial demonstrates how to: 

 Import properties from a database. 

 Define a combustion reaction. 

 Replicate and rotate obstructions (furniture). 

 Use a hole to represent an open door. 

 Define an open surface on the exterior of the model. 

 View 3D results using Smokeview. 

 View 2D results using PyroSim. 
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The FDS input file listing for this model is provided at the end of this document. You can import this 

directly into PyroSim. 

Brief Overview of Fire Modeling 
In FDS/PyroSim, a fire is defined by a reaction, pyrolysis, and combustion: 

1. Reaction – A reaction assumes a fuel vapor that reacts with oxygen to release energy and form 

combustion products. 

2. Pyrolysis – This defines the rate at which solid or liquid surfaces generation fuel vapor. For 

example wood is heated and releases combustible gas or candle wax melts, is drawn up the 

wick, and vaporized. 

3. Combustion – This is the reaction process by which fuel vapor mixes with oxygen and creates 

products based on the chemical reaction. The fuel vapor results from pyrolysis, oxygen is 

provided by air. The combustion process mixes fuel and oxygen and controls the reaction rate. 

A more complete discussion of these processes is described in the FDS User Manual (Pyrolysis in Chapter 

8 and Combustion in Chapter 12). On the PyroSim web site, the Resources also provide links to a set of 

videos that further explain the details (see PyroSim: Modeling Fire, Part 1 – Reactions, Part 2 - Heat 

Release Rate, and Part 3 - Combustion using HRR). 

Standard Approach to Fire Modeling 

The most frequently used approach to modeling a reaction in FDS/PyroSim assumes a single fuel species 

composed of C, H, O, and N that reacts with air to form products H2O, CO2, soot, and CO. The user 

specifies the chemical formula of the fuel (and the yields for soot and CO and hydrogen fraction in soot), 

and FDS/PyroSim calculates the stoichiometric coefficients and heat release rate. 

The most common way to define pyrolysis in FDS/PyroSim is to specify a Heat Release Rate (HRR) on a 

surface. When HRR is specified, FDS uses the heat of combustion defined by the reaction to calculate the 

fuel vapor mass release rate that will result that will result in the desired energy release. 

The most commonly used combustion model in FDS/PyroSim is the “simple chemistry” model, in which 

the reaction of fuel and oxygen is infinitely fast and controlled only by mixing. 

More Complex Solid Phase Pyrolysis used in this Example 

While this example uses the standard approach to define the reaction and combustion, it uses a much 

more complicated approach for the calculation of the solid phase pyrolysis (the conversion of the solid 

to fuel vapor). 

In this example, fuel vapor mass release rate is calculated by actually simulating solid phase pyrolysis 

using a layered surface and a pyrolysis rate defined by the material properties. Layered surfaces are 

used so that a heat transfer calculation can be performed. The temperature is then used to calculate the 

solid phase pyrolysis rate. See the FDS User Manual (Pyrolysis in Chapter 8 and Combustion in Chapter 

12) for more information. 
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Start a New Model 
Run PyroSim. 

1. To clear any open models, on the File menu, click New. 

2. On the View menu, click Units and select SI to display values using the metric system. 

3. Save the model. On the File menu, click Save and choose a folder. Name the file roomfire.psm. 

4. Click OK to save the model. 

Reaction 
First we define the reaction for this simulation. 

1. On the Model menu, click Edit Reactions. 

2. Click the Add From Library button, select POLYURETHANE reaction, and move it to the Current 

Model. Click Close.  

3. Click OK to close the dialog. 

Create the Mesh 
The mesh (or meshes) define the computational domain. It is convenient to define the mesh early and 

use it to help create geometry. You can always modify or refine the mesh later. 

In this example we will use mesh cells with a size of 0.10 m. This is geometrically convenient and is 

somewhat smaller than 1/5 of the characteristic diameter (D*) for a 500 kW fire. In this simulation, the 

fire is ignited and grows, so there is not a single value of heat release rate with which to calculate D*. 

It is the responsibility of the analyst to run verification calculations that show the mesh resolution is 

sufficiently small so that the results have converged. This is a compromise. Using mesh cells that are 

smaller by a factor of 2 should decrease error by a factor of 4, but will increase the simulation run time 

by a factor of 16. 

1. On the Model menu, click Edit Meshes. 

2. Click New and then OK to create a new mesh. 

3. In the Min X box, type 0 and in the Max X box, type 5.2. 

4. In the Min Y box, type -0.8 and in the Max Y box, type 4.6. 

5. In the Min Z box, type 0 and in the Max Z box, type 2.4. 

6. In the X Cells box, type 52. 

7. In the Y Cells box, type 54. 

8. In the Z Cells box, type 24. 

9. Click OK to save changes and close the Edit Meshes dialog. 

10. On the View menu, click Reset View to All Objects. 

Import Material Data 
Materials are the building blocks for Surfaces that are used to define the geometry of the model. 

PyroSim includes a database file that provides data and references for the source of the data. We will 

import selected properties from this file.  
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1. On the Model menu, click Edit Materials. 

2. Copy the FOAM, GYPSUM, and YELLOW PINE materials from the library into the Current Model. 

3. Close the PyroSim Libraries dialog. 

 

Figure 2. Copy the materials from the library into the current model 

Because this ignition and burn-away simulation is sensitive to material properties, we will edit the 

imported FOAM material to have the same values as used in the NIST room fire example (the GYPSUM 

and YELLOW PINE do not affect the simulation, so we will leave them with the imported properties). To 

edit FOAM: 

1. In the Edit Materials dialog, double-click on FOAM. 

2. In the Description box, type NIST – Completely Made Up. 

3. In the Density box, type 40. 

4. In the Specific Heat box, type 1. 

5. Click the Pyrolysis tab. 

6. In the Heat of Combustion box, type 30000. 

7. Under Reaction, click Edit. 

8. In the Reference Temperature box, type 300. 

9. Click the Byproducts tab. 

10. In the Heat of Reaction box, type 800. 

11. In the Composition column, type 1. 

12. In the Residue column select [Species: SPEC] REAC_FUEL. This means that the pyrolysis 

byproducts will be the fuel.  

13. Click OK to close the Edit Pyrolysis Reaction dialog. 
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14. Click Apply to save the changes. 

The sofa cushions will be made of a thin layer of fabric that covers a foam pad. No default fabric is 

provided in the PyroSim libraries, so we will create one. The values used for this material are the same 

as used in the NIST model. Note – NIST clearly states the fabric properties are not realistic, so should not 

be used for other models without justification. 

To add a new material:  

1. In the Edit Materials click New.  

2. In the Name box, type Fabric. Click OK. 

3. In the Density box, type 100. Do not change the default values for the other Thermal Properties.  

4. Click the Pyrolysis tab. 

5. Select the Heat of Combustion checkbox and in the value box type 15000. 

6. Under Reaction, click Add. 

7. In the Reference Temperature box, type 280.  

8. Click the Byproducts tab. 

9. Select the Heat of Reaction option and in the box, type 1000. The reaction is Endothermic, that 

is, pyrolysis requires energy input to occur. 

10. In the Composition column, type 1. 

11. In the Residue column select [Species: SPEC] REAC_FUEL. This means that the pyrolysis 

byproducts will be the fuel.  

12. Click OK to close the Edit Pyrolysis Reaction dialog. 

13. Click OK to close the Edit Materials dialog. 

Create Surfaces 
Materials define physical properties. Solid surfaces can use the material properties to calculate the 

thermal response.  

The floor will be made of yellow pine material. To create the surface: 

1. On the Model menu, click Edit Surfaces. 

2. Click New, give the Surface Name as Pine, select the Surface Type as Layered, and click OK. A 

layered surface will calculate heat conduction into the surface. 

3. Click on the Appearance box and select psm_wood2.jpg. Click OK to close the Texture dialog. 

4. In the Material Layers tab, in the Thickness column, type 0.01. 

5. The material composition can be defined as a mixture. Click the Edit button. In the Mass 

Fraction column, type 1.0. In the Material column, select YELLOW PINE. Click OK to close the 

Composition dialog. 

6. In the Edit Surfaces dialog, click Apply to save the changes. 
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Figure 3. Creating the Pine floor surface 

We will use gypsum for the walls: 

1. In the Edit Surfaces dialog, click New. Give the Surface Name as Gypsum, select the Surface 

Type as Layered, and click OK. 

2. Click on the Color box and define a neutral blue color (e.g. RGB of 198, 225, 230 and Alpha 255). 

Click OK to close the Surface Color dialog. 

3. In the Material Layers panel, in the Thickness column, type 0.013. 

4. Click the Edit button. In the Mass Fraction column, type 1.0. In the Material column, select 

GYPSUM. Click OK to close the Composition dialog. 

5. In the Edit Surfaces dialog, click Apply to save the changes. 

The upholstery will have a fabric surface and a foam core: 

1. In the Edit Surfaces dialog, click New. Give the Surface Name as Upholstery, select the Surface 

Type as Layered, and click OK. 

2. Click on the Color box and select a grey color (e.g. RGB of 120, 116, 110 and Alpha 255). Click OK 

to close the Surface Color dialog. 

3. In the Material Layers we define the two materials for the upholstery. First the fabric. In the 

Thickness column, type 0.002. Click the Edit button. In the Mass Fraction column, type 1.0. In 

the Material column, select Fabric. Click OK to close the Composition dialog. 
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4. Now we add the foam. Click Insert Row. In the Thickness column, type 0.1. Click the Edit button. 

In the Mass Fraction column, type 1.0. In the Material column, select FOAM. Click OK to close 

the Composition dialog. You should now have two material layers in the upholstery surface. 

5. Click on the Surface Props tab. In the Backing box, select Insulated. 

6. Click on the Reaction tab. Select Allow the Obstruction to Burn Away. When this option is 

selected, the solid object disappears from the calculation cell by cell, as the mass contained by 

each mesh cells is consumed either by the pyrolysis reactions or by the prescribed HRR. 

7. In the Edit Surfaces dialog, click Apply to save the changes. 

 

Figure 4: The upholstery has two material layers. 

We will place an initial ignitor object on the sofa. This ignitor will be at a constant temperature of 1000 

°C and will radiate heat that will ignite the upholstery. To create this burner surface: 

1. In the Edit Surfaces dialog, click New. Give the Surface Name as Ignitor, select the Surface Type 

as Heater/Cooler, and click OK. 

2. In the Thermal tab, in the Boundary Condition Model, select Fixed Temperature. This means 

the surface will stay at a constant temperature. 

3. In the Thermal tab, in the Surface Temperature box, type 1000. Leave the Emissivity at 0.9. 

4. Click the Geometry tab, in the Geometry list, select Cylindrical. In the Radius box, type 0.01; in 

the Length box, type 0.15. 

5. In the Edit Surfaces dialog, click OK to save the changes and close the dialog. 
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Note that since the ignitor just keeps a constant surface temperature, we did not have to define any 

material properties for the surface. 

Create Furniture (Obstructions) 
We will now add furniture to the model. 

Couch 

The first will be a couch. Create a Couch group that will help us organize the input. 

1. Right-click the Model category in the tree view. 

2. On the Model menu, click New Group. The Parent Group will be Model. 

3. In the Group Name box, type Couch. 

4. Click OK to close the Create Group dialog. 

To create the seat: 

1. On the Model menu, click New Obstruction. 

2. In the ID box, type Seat cushion. 

3. In the Group list, select Couch. 

4. On the Geometry tab, enter the values in Table 1. 

5. On the Surfaces tab, select Single and select Upholstery from the list. 

6. Click OK to close the Obstruction Properties dialog. 

Table 1. Couch seat dimensions 

 X Y Z 

Min 1.5 3.8 0.2 

Max 3.1 4.6 0.6 

 

To create the right armrest: 

1. On the Model menu, click New Obstruction. 

2. In the ID box, type Right armrest. 

3. In the Group list, select Couch. 

4. On the Geometry tab, enter the values in Table 2. 

5. On the Surfaces tab, select Single and select Upholstery from the list. 

6. Click OK to close the Obstruction Properties dialog. 

Table 2. Right armrest dimensions 

 X Y Z 

Min 1.3 3.8 0.0 

Max 1.5 4.6 0.9 

 

We will use the copy function to create the left armrest. 
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1. Right-click the Right armrest either in the Tree View or the 3D view. 

2. Click Copy/Move. 

3. In the Mode options, select Copy with 1 copy. 

4. In the Offset boxes, enter X = 1.8, Y = 0.0, and Z = 0.0. 

5. Click OK to close the Translate dialog. 

To rename the copy, double-click on the Right armrest in the Tree view and change the ID to Left 

armrest. Click OK. 

To create the back: 

1. On the Model menu, click New Obstruction. 

2. In the ID box, type Back cushion. 

3. In the Group list, select Couch. 

4. On the Geometry tab, enter the values in Table 3. 

5. On the Surfaces tab, select Single and select Upholstery from the list. 

6. Click OK to close the Obstruction Properties dialog. 

Table 3. Couch back dimensions 

 X Y Z 

Min 1.5 4.4 0.6 

Max 3.1 4.6 1.2 

 

The display will appear as shown in Figure 5. 

 

Figure 5. The room after the couch is added 
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Second Couch 

We will now create a second couch using the copy function. 

1. In the Tree View, right-click the Couch group. 

2. Click Copy/Move. 

3. In the Mode options, select Copy with 1 copy. 

4. In the Offset boxes, enter X = -1.3, Y = -3.6, and Z = 0.0. 

5. Click OK to close the Translate dialog. 

Rotate the second couch to lie against the well. 

1. In the Tree View, right-click the new Couch group. 

2. Click Rotate. 

3. In the Mode options, select Move. 

4. In the Angle box, type 90. 

5. In the Base Point boxes, enter X = 0.0 and Y = 1.0. 

6. Click OK to close the Rotate Objects dialog. 

Additional Furniture 

Add a pad: 

1. On the Model menu, click New Obstruction. 

2. In the ID box, type Pad. 

3. In the Group list, select Model. 

4. On the Geometry tab, enter the values in Table 4. 

5. On the Surfaces tab, select Single and select Upholstery from the list. 

6. Click OK to close the Obstruction Properties dialog. 

Table 4. Table dimensions 

 X Y Z 

Min 1.6 2.4 0.0 

Max 3.0 3.2 0.2 

 

The resulting room display is shown in Figure 6. 
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Figure 6. The resulting room display 

Constructing complex objects can be time consuming and PyroSim supports several options. If your 

geometry is available in DXF, DWG, or STL format, PyroSim supports import. You can also import existing 

FDS models. For walls, PyroSim provides sketching on a background image. Alternately, if you use the 

same geometry in many models, you can create the geometry and save it. You can then copy any object 

from one model to another. You can even copy the text from an FDS input file and paste it into a 

PyroSim model. 

Walls 
We will add a wall using the 2D View. Since we will be adding only one interior wall, this wall could also 

be added quickly as a single obstruction. However, we will use the 2D view in order to demonstrate its 

use. 

1. Select the 2D View. Click the Reset tool. 

2. Select the Wall (  ) Tool. 

3. Click Tool Properties (  ). In the Name box, type Wall. Set the Z Location to 0.0, the Height to 

2.4, the Thickness to 0.2, and change the Surface Prop to Gypsum. Click OK. 

4. With the wall tool draw the wall from left to right along the Y=0 line. Press the CTRL key to flip 

the wall to the lower part of the model, Figure 7. 
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Figure 7. Drawing the wall 

Create Door (Hole in Wall) 
To add a door by creating a hole in the wall: 

1. On the Model menu, click New Hole. 

2. In the ID box, type Door. 

3. In the Group list, select Model. 

4. On the Geometry tab, enter the values in Table 5. Note that we extend the hole beyond the 

bounds of the wall it intersects. This ensures the hole will take priority over the wall. 

5. Click OK to close the Obstruction Properties dialog. 

Table 5. Door dimensions 

 X Y Z 

Min 4.0 -0.3 0.0 

Max 4.9 0.1 2.0 

 

The model now looks like: 
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Figure 8. The model after adding the door 

Use Vents to Define the Floor, Walls, and Ceiling 
In FDS, Vents are used to describe 2D planar objects. In this example, we use vents to define the wood 

floor and the gypsum walls and ceiling. We do this because we want the walls and ceiling to heat up as a 

result of the fire. If we just used the default inert surface, they would stay at a constant temperature (20 

°C by default). 

To create the floor: 

1. On the Model menu, click New Vent. 

2. In the ID box, type Floor. 

3. In the Group list, select Model. 

4. In the Surface list, select Pine. 

5. Click on the Geometry tab. In the Plane list, select Z and give the value as 0.001. 

6. In the Bounds boxes, enter the values in Table 6. 

7. Click OK to close the Vent Properties dialog. 

Table 6. Floor dimensions 

 X Y 

Min 0.0 0.0 

Max 5.2 4.6 

 

Now we will define the walls and ceiling. These are created using vents and the Gypsum surface. To 

make these vents, use the information in Table 7. 
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Table 7. Wall and ceiling dimensions 

Vent Surface Plane Min X Max X Min Y Max Y Min Z Max Z 

Back Wall Gypsum Y=4.6 0 5.2   0 2.4 

Left Wall Gypsum X=0   0 4.6 0 2.4 

Right Wall Gypsum X=5.2   0 4.6 0 2.4 

Ceiling Gypsum Z=2.4 0 5.2 0 4.6   

 

Create Ignitors that will light the Fire 
In this model, we will define ignitors that will glow at a fixed temperature, heat the sofa, and ignite the 

sofa. Creating the ignitors is a two-step process: first we define particles, then we position them in the 

model. 

To define the particles: 

1. On the Model menu, click Edit Particles. 

2. Click New. In the Particle Name box, type Ignitor Particle. 

3. In the Particle Type list, select Solid. 

4. Click OK to create the particle. 

5. On the Solid tab, for Surface, select Ignitor (this is the fixed temperature surface we previously 

created. 

6. In the Movement option, select Particles are Stationary. 

7. Click the Injection tab. In the Duration box, type 1E5. This means that the particle will remain in 

the model for the entire simulation. 

8. Click OK to close the Edit Particles dialog. 

Now we will create the actual ignitors. First create an Ignitor group: 

1. Click the Model category in the tree view. 

2. On the Model menu, click New Group. The Parent Group will be Model. 

3. In the Group Name box, type Ignitors. 

4. Click OK to close the Create Group dialog. 

Now create the first ignitor: 

1. On the Model menu, click New Particle Location. 

2. In the ID box, type Ignitor. 

3. In the Group list, select Ignitors. 

4. In the Particle list, select Ignitor Particle. 

5. In the Droplet Count select Constant and change the number to 1. 

6. Click the Geometry tab. In the Location Properties boxes, enter the values in Table 8. 

7. Click OK to close the Particle Cloud Properties dialog. 



 Room Fire  

16 
 

Table 8. Ignitor location 

X Y Z 

2.45 4.35 0.65 

 

Copy to create two more ignitors: 

1. Right-click on the Ignitor and select Copy/Move. 

2. In the Model options, select Copy and in the Number of Copies box, type 2. 

3. In the Offset boxes, enter the values in Table 9. 

4. Click OK to close the Translate dialog. 

Table 9. Ignitor Offsets 

X Y Z 

0.1 0.0 0.0 

 

Add Open Boundary 
We will add an open boundary on the model outside the door. PyroSim provides a shortcut that can 

create open vents on mesh boundaries. 

1. In the navigation view, right-click on the MESH01 and click Open Mesh Boundaries. This will add 

a group named Vents for MESH that includes vents on each grid boundary. 

2. Delete four vents, the XMAX, XMIN, YMAX, and ZMIN vents. 

3. Now double-click the Mesh Vent: Mesh [ZMAX] vent. Click the Geometry tab, and change Max 

Y to 0. Click OK. 

Now there are just two open vents. One opposite the door and one above the door. This will let smoke 

leave the door and flow up. It will also allow cold air to flow in the lower half of the door. 

Create Thermocouple Records 
We will first create one thermocouple near the ceiling and then replicate it to create a stack of 

thermocouples. 

1. On the Devices menu, click New Thermocouple. 

2. In the Location boxes, enter X = 2.6, Y = 2.3, and Z = 2.1. 

3. Click OK to close the Thermocouple dialog. 

To copy the thermocouple: 

1. Right-click on THCP and click Copy/Move. 

2. In the Mode, select Copy with the Number of copies 5. 

3. In the Offset boxes, enter X = 0.0, Y =0.0, and Z = -0.3. 

4. Click OK to close the Translate dialog. 
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5. Click the LBL icon to toggle labels off. Click the Devices icon to toggle devices off. 

Create Layer Zoning Device 
The upper and lower layers in the room can be calculated using the Layer Zone Device. To create this: 

1. On the Devices menu, click New Layer Zoning Device. 

2. Select the three checkboxes to enable, measuring of Layer Height, Upper Temperature, and 

Lower Temperature.  

3. In the End Point boxes enter the data in Table 10. 

4. Click OK to close the Layer Zoning Device dialog. 

Table 10. Layer Zone Geometry 

 X Y Z 

End Point 1 2.6 2.3 0 

End Point 2 2.6 2.3 2.4 

 

Create Slice Records for Results Plotting 
Slice planes can be used to display 2D contours in the Smokeview display of the results. In this analysis, 

we will save temperature and velocity data for future plotting. To define the slice plane: 

1. On the Output menu, click Slices. 

2. Fill the table by entering the values in Table 11.  

3. Click OK to close the Animated Planar Slices dialog. 

Table 11. Slice plane data 

XYZ Plane Plane Value (m) Gas Phase Quantity Use Vector? 

X 2.6 Temperature NO 

X 4.45 Velocity YES 

Create Surface Plots 
Temperatures (and other quantities) on the surface of objects can be plotted. To define the surface 

plots: 

1. On the Output menu, click Boundary Quantities. 

2. Click the Wall Temperature checkbox. 

3. Click OK to close the Animated Boundary Quantities dialog. 

Specify Simulation Properties 
To define the end time: 

1. On the FDS menu, click Simulation Parameters. 

2. In the Simulation Title box, type Room fire. 
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3. In the End Time box, type 150 s. 

4. Click OK. 

Hang a Picture on the Wall 
Let us fancy things up by hanging a picture on the wall. First decide what picture you want to hang. 

1. On the Model menu, click Edit Surfaces. 

2. In the Edit Surfaces dialog, click New. Give the Surface Name as Picture, select the Surface Type 

as Basic (this is just an INERT surface that you can name), and click OK. 

3. Click on the Appearance box. 

4. Click the Import button and select the image you want as a picture. In homage to my Dad and 

Brother, I used the image called motorcycle.jpg. That is me in the middle. Right-click the link and 

click Save Link As to download the image if you would like to use it. 

5. The image you selected will be displayed. Set the Width to 1.0 and the Height to 0.675 (or 

whatever values are appropriate for your image.) 

6. Click OK to close the Textures dialog. 

7. Click OK to close the Edit Surfaces dialog. 

We now create a vent that uses the texture. 

1. On the Model menu, click New Vent. 

2. In the ID box, type Picture. 

3. In the Group list, select Model. 

4. In the Surface list, select Picture. 

5. Under Texture Origin, click to select Relative to Object. 

6. Click the Geometry tab. In the Plane list, select Y and give the value as 4.599. 

7. In the Bounds boxes, enter the values in Table 12. 

8. Click OK to close the Vent Properties dialog. 

Table 12. Picture dimensions 

 X Z 

Min 3.6 1.2 

Max 4.6 1.875 

 

The Model is Complete 
Your model should now look like Figure 9. Save it. 

http://thunderheadeng.com/downloads/7428
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Figure 9. Completed model 

Run the Analysis 
To run the analysis: 

1. On the FDS menu, click Run FDS. If asked to expand holes, click Yes. You will receive a warning 

that two vents overlap. This is caused by the picture on the wall. The solution will use the 

gypsum wall vent and ignore the picture vent in the calculation. 

View the Results 
An image showing the smoke, heat release rate, and velocity vectors is shown in Figure 10. This is a time 

when the sofa has begun to burn, but the fire is still relatively small. You can clearly see the air 

circulation caused by the fire, with hot air flowing out the top half of the door and cold air flowing in the 

bottom half of the door. The smoke has formed a layer. 
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Figure 10. Plot showing smoke, heat release rate isosurface, and velocity vectors. You can see the 

formation of layers, the hot air and products flowing out the top of the door, and fresh air flowing in 

the bottom of the door. 

A plot of surface temperature is given in Figure 11. Notice that parts of the sofa have burned away. To 

show this plot, in Smokeview, right-click and select Show/Hide » Geometry » Obstacles » *Actual. 

 

Figure 11: Plot of surface temperature. Notice that the sofa has burned away. In Smokeview, set the 
Obstacles location to Actual. 
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To view time history results 

1. In the PyroSim toolbar, click Plot Thermal Results. 

2. Plot the heat release rate as a function of time, Figure 12. This is an extreme fire with flashover. 

You can also make plots of the thermocouple readings and the layer height. 

 

Figure 12. Heat release rate. 
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FDS Input File 
Following is a listing of the FDS input file. You can either save this as a text file and import into PyroSim, 

or you can: 

1. Open PyroSim and on the File menu, click New. 

2. Select and copy the entire listing below. 

3. On the PyroSim Edit menu, click Paste. You will receive two warnings. The first is related to 

textures. Since we are just pasting the FDS input data, we will lose the links to the wood floor 

and wall picture textures. You can go back and add those in PyroSim, if desired. Select OK. The 

second warning is that Simulation Parameters already exists in the model, click Yes to All to 

replace all existing data with the FDS file data. 

4. Click the Reset tool. 

5. Save and run. 

roomfire.fds 

Generated by PyroSim - Version 2015.4.1125 

Nov 25, 2015 1:58:20 PM 

 

&HEAD CHID='roomfire'/ 

&TIME T_END=200.0/ 

&DUMP RENDER_FILE='roomfire.ge1', COLUMN_DUMP_LIMIT=.TRUE., DT_RESTART=300.0/ 

 

&MESH ID='Mesh01', IJK=52,54,24, XB=0.0,5.2,-0.8,4.6,0.0,2.4/ 

 

&PART ID='Ignitor Particle', 

      STATIC=.TRUE., 

      SURF_ID='Ignitor'/ 

 

&REAC ID='POLYURETHANE', 

      FYI='NFPA Babrauskas', 

      FUEL='REAC_FUEL', 

      C=6.3, 

      H=7.1, 

      O=2.1, 

      N=1.0, 

      SOOT_YIELD=0.1/ 

 

&DEVC ID='THCP', QUANTITY='THERMOCOUPLE', XYZ=2.6,2.3,2.1/ 

&DEVC ID='THCP01', QUANTITY='THERMOCOUPLE', XYZ=2.6,2.3,1.8/ 

&DEVC ID='THCP02', QUANTITY='THERMOCOUPLE', XYZ=2.6,2.3,1.5/ 

&DEVC ID='THCP03', QUANTITY='THERMOCOUPLE', XYZ=2.6,2.3,1.2/ 

&DEVC ID='THCP04', QUANTITY='THERMOCOUPLE', XYZ=2.6,2.3,0.9/ 

&DEVC ID='THCP05', QUANTITY='THERMOCOUPLE', XYZ=2.6,2.3,0.6/ 

&DEVC ID='LAYER->HEIGHT', QUANTITY='LAYER HEIGHT', XB=2.6,2.6,2.3,2.3,0.0,2.4/ 

&DEVC ID='LAYER->LTEMP', QUANTITY='LOWER TEMPERATURE', 

XB=2.6,2.6,2.3,2.3,0.0,2.4/ 

&DEVC ID='LAYER->UTEMP', QUANTITY='UPPER TEMPERATURE', 

XB=2.6,2.6,2.3,2.3,0.0,2.4/ 

&MATL ID='Fabric', 
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      SPECIFIC_HEAT=1.0, 

      CONDUCTIVITY=0.1, 

      DENSITY=100.0, 

      HEAT_OF_COMBUSTION=1.5E4, 

      N_REACTIONS=1, 

      HEAT_OF_REACTION=1000.0, 

      SPEC_ID(1,1)='REAC_FUEL', 

      NU_SPEC(1,1)=1.0, 

      REFERENCE_TEMPERATURE=280.0/ 

&MATL ID='FOAM', 

      FYI='Caution: Reaction Rate Not Validated, remaining data from Jukka 

Hietaniemi, et al., "FDS simulation of fire spread..."', 

      SPECIFIC_HEAT=1.0, 

      CONDUCTIVITY=0.05, 

      DENSITY=40.0, 

      HEAT_OF_COMBUSTION=3.0E4, 

      N_REACTIONS=1, 

      HEAT_OF_REACTION=800.0, 

      SPEC_ID(1,1)='REAC_FUEL', 

      NU_SPEC(1,1)=1.0, 

      REFERENCE_TEMPERATURE=300.0/ 

&MATL ID='GYPSUM', 

      FYI='NBSIR 88-3752 - ATF NIST Multi-Floor Validation', 

      SPECIFIC_HEAT=1.09, 

      CONDUCTIVITY=0.17, 

      DENSITY=930.0/ 

&MATL ID='YELLOW PINE', 

      FYI='Quintiere, Fire Behavior - NIST NRC Validation', 

      SPECIFIC_HEAT=2.85, 

      CONDUCTIVITY=0.14, 

      DENSITY=640.0/ 

 

&SURF ID='Upholstery', 

      RGB=120.0,116.0,110.0, 

      BURN_AWAY=.TRUE., 

      BACKING='INSULATED', 

      MATL_ID(1,1)='Fabric', 

      MATL_ID(2,1)='FOAM', 

      MATL_MASS_FRACTION(1,1)=1.0, 

      MATL_MASS_FRACTION(2,1)=1.0, 

      THICKNESS(1:2)=0.002,0.1/ 

&SURF ID='Gypsum', 

      RGB=198.0,225.0,230.0, 

      BACKING='VOID', 

      MATL_ID(1,1)='GYPSUM', 

      MATL_MASS_FRACTION(1,1)=1.0, 

      THICKNESS(1)=0.013/ 

&SURF ID='Pine', 

      RGB=146.0,202.0,166.0, 

      TEXTURE_MAP='psm_wood2.jpg', 

      TEXTURE_WIDTH=0.6096, 

      TEXTURE_HEIGHT=0.6096, 

      BACKING='VOID', 

      MATL_ID(1,1)='YELLOW PINE', 
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      MATL_MASS_FRACTION(1,1)=1.0, 

      THICKNESS(1)=0.01/ 

&SURF ID='Ignitor', 

      RGB=255.0,102.0,0.0, 

      TMP_FRONT=1000.0, 

      GEOMETRY='CYLINDRICAL', 

      LENGTH=0.15, 

      RADIUS=0.01/ 

&SURF ID='Picture', 

      TEXTURE_MAP='motorcycle_1.jpg', 

      TEXTURE_HEIGHT=0.675/ 

 

&INIT ID='Ignitor', PART_ID='Ignitor Particle', N_PARTICLES=1, 

XYZ=2.45,4.35,0.65/ 

&INIT ID='Ignitor', PART_ID='Ignitor Particle', N_PARTICLES=1, 

XYZ=2.55,4.35,0.65/ 

&INIT ID='Ignitor', PART_ID='Ignitor Particle', N_PARTICLES=1, 

XYZ=2.65,4.35,0.65/ 

 

&OBST XB=1.5,3.1,3.8,4.6,0.2,0.6, SURF_ID='Upholstery'/ Seat cushion 

&OBST XB=1.3,1.5,3.8,4.6,0.0,0.9, SURF_ID='Upholstery'/ Right armrest 

&OBST XB=3.1,3.3,3.8,4.6,0.0,0.9, SURF_ID='Upholstery'/ Left armrest 

&OBST XB=1.5,3.1,4.4,4.6,0.6,1.2, SURF_ID='Upholstery'/ Back cushion 

&OBST XB=8.88178E-16,0.8,1.2,2.8,0.2,0.6, SURF_ID='Upholstery'/ Seat cushion 

&OBST XB=4.44089E-16,0.8,1.0,1.2,0.0,0.9, SURF_ID='Upholstery'/ Right armrest 

&OBST XB=8.88178E-16,0.8,2.8,3.0,0.0,0.9, SURF_ID='Upholstery'/ Left armrest 

&OBST XB=8.88178E-16,0.2,1.2,2.8,0.6,1.2, SURF_ID='Upholstery'/ Back cushion 

&OBST XB=1.6,3.0,2.4,3.2,0.0,0.2, SURF_ID='Upholstery'/ Pad 

&OBST XB=0.0,5.2,-0.2,-1.94289E-16,0.0,2.4, SURF_ID='Gypsum'/ Wall 

 

&HOLE XB=4.0,4.9,-0.3,0.1,-0.01,2.0/ Door 

 

&VENT SURF_ID='OPEN', XB=0.0,5.2,-0.8,-0.8,0.0,2.4/ Mesh Vent: Mesh01 [YMIN] 

&VENT SURF_ID='OPEN', XB=0.0,5.2,-0.8,0.0,2.4,2.4/ Mesh Vent: Mesh01 [ZMAX] 

&VENT SURF_ID='Pine', XB=0.0,5.2,0.0,4.6,0.001,0.001/ Floor 

&VENT SURF_ID='Gypsum', XB=0.0,5.2,4.6,4.6,0.0,2.4/ Back Wall 

&VENT SURF_ID='Gypsum', XB=0.0,0.0,0.0,4.6,0.0,2.4/ Left Wall 

&VENT SURF_ID='Gypsum', XB=5.2,5.2,0.0,4.6,0.0,2.4/ Right Wall 

&VENT SURF_ID='Gypsum', XB=0.0,5.2,0.0,4.6,2.4,2.4/ Ceiling 

&VENT SURF_ID='Picture', XB=3.6,4.6,4.599,4.599,1.2,1.875, 

TEXTURE_ORIGIN=3.6,4.599,1.2/ Picture 

 

&BNDF QUANTITY='WALL TEMPERATURE'/ 

 

&SLCF QUANTITY='TEMPERATURE', PBX=2.6/ 

&SLCF QUANTITY='VELOCITY', VECTOR=.TRUE., PBX=4.45/ 

 

&TAIL / 
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Original NIST FDS Verification Input File 
This example we created is a simplification of the room fire problem provided by NIST as an FDS 

verification problem. You can download the complete original FDS verification file at: 

https://github.com/firemodels/fds-smv/blob/development/Verification/Fires/room_fire.fds  

To import the original FDS file into PyroSim, on the File menu, click Import FDS/CAD File. During import, 

specify that the NIST model was created using FDS 6. 

The simplifications we made in the example are mostly related to geometry. You will notice that the 

default FOAM material properties we used are different than the NIST verification values (NIST 

specifically says their values are fabricated and not to be used for other simulations). 

 

https://github.com/firemodels/fds-smv/blob/development/Verification/Fires/room_fire.fds

